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Preface

Welcome to the Opsware Operational Management Database (OMDB), the first
configuration management database (CMDB) that offers seamless change automation.
Leveraging the Opsware System consisting of the Opsware Server Automation System
(SAS), Opsware Network Automation System (NAS), and the Opsware Application Storage
Automation System (ASAS), the OMDB automatically populates and maintains all the
infrastructure configuration items (Cls), their detailed attributes, and interdependencies.
After the OMDB is populated with the data, customers can easily execute changes to
configure and remediate the IT infrastructure.

Overview of this Guide

This guide describes installing OMDB and Data Miners, and how to perform OMDB
administrative tasks.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: Supported Operating Systems: Describes the supported operating systems
for an Opsware OMDB core, OMDB Database, and the OMDB Client.

Chapter 2: Installing OMDB: Describes how to install OMDB Core and Database
instances, and how to configure SAS groups to permit access to OMDB.

Chapter 3: Installing OMDB Data Miners: Describes how to install OMDB Data Miners.
Chapter 4: Administrative Tasks: Describes the OMDB filesystem layout, viewing and
setting OMDB permissions, creating and assigning security boundaries, and the OMDB
start script.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Conventions in this Guide

This guide uses the following typographical and formatting conventions.

Bold Identifies field menu names, menu items, button names, and
inline terms that begin with a bullet.

Courier Identifies text that is entered or displayed at the
command-line prompt, such as Unix commands, Opsware
SAS commands, file names, paths, directories, environment
variable names, contents of text files that are viewed or edited
with a text editor, source code in a programming language,
and SQL (database) commands.

ltalics Identifies document titles, DVD titles, web site addresses.
Used to introduce new terms when they are first defined in a
document and for emphasis.

Icons in this Guide

This guide uses the following icons.

This icon represents a note. It identifies especially important
concepts that warrant added emphasis.

This icon represents a requirement. It identifies a task that
must be performed before an action under discussion can be

Iz performed.

This icon represents a tip. It identifies information that can
help simplify or clarify tasks.

W
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This icon represents a warning. It is used to identify significant
i information that must be read before proceeding.

Guides in the Documentation Set and Associated Users

The Opsware® SAS User's Guide: Server Automation is intended for system
administrators responsible for all aspects of managing servers in an operational
environment. It describes how to use Opsware SAS, introducing the system and the
user interface. It provides information about managing servers, remediating servers,
script execution, configuration tracking, deploying and rolling back code, and agent
deployment. It also explains how to use the Opsware Global Shell and open a Remote
Terminal on managed servers.

O,osware® SAS User’s Guide: Application Automation is intended for system
administrators responsible for performing the day-to-day functions of managing
servers. It reviews auditing and compliance, software packaging, visual application
management, application configuration, and software and operating system installation
on managed servers.

The Opsware® SAS Administration Guide is intended for administrators responsible for
monitoring and diagnosing the health of the Opsware SAS core components. It also
documents how to set up Opsware user groups and permissions.

The Opsware® SAS Planning and Installation Guide is intended for advanced system
administrators responsible for planning all facets of an Opsware SAS installation. It
documents all the main features of Opsware SAS, scopes out the planning tasks
necessary to successfully install Opsware SAS, explains how to run the Opsware
Installer, and details how to configure each of the components. It also includes
information on system sizing and checklists for installation.

The O,osware® SAS Policy Setter’s Guide is intended for system administrators
responsible for setting up OS provisioning, configuration tracking, code deployment,
and software management.

The Opsware® SAS Content Utilities Guide is intended for advanced system
administrators responsible for importing content such as software packages into

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Opsware SAS. It documents the following command-line utilities: OCLI 1.0, IDK, and
DET (CBT).

* The Opsware® Automation Platform Developer’'s Guide is intended for software
developers responsible for customizing, extending, and integrating Opsware SAS. It
documents how to create Web Services, Java RMI, Python, and CLI clients that invoke
methods on the Opsware API.

Opsware, Inc. Contact Information

For more information, see the Opsware, Inc. main web site and phone number:
* http://www.opsware.com/index.htm
+ 41 (408) 744-7300

For links to the latest product documentation and software downloads, see the Opsware
Customer Support site:

* https://download.opsware.com/opsw/main.htm
For troubleshooting information, see the Opsware Knowledge Base:
* https://download.opsware.com/kb/kbindex.jspa

To contact Opsware Customer Support, see the following email address and phone
number:

* support@opsware.com

* +1(877) 677-9273

1 O Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 1: Supported Platforms

IN THIS CHAPTER

This chapter contains the following sections:

+ Supported Operating Systems for OMDB Core Servers
+ Supported Operating Systems for the OMDB Client

« Hardware Requirements for OMDB Core Servers

Supported Operating Systems for OMDB Core Servers

The following table lists the supported operating systems for the Opsware OMDB core
components.

Table 1-1: Opsware OMDB Core Supported Operating Systems

SUP;?AF;1'BE28:EFOR VERSIONS ARCHITECTURE COMCI)’I\(I'I)?‘IENTS

Sun Solaris Solaris 9 Sun SPARC All components

Sun Solaris Solaris 10 Sun SPARC, Niagara| All components

Red Hat Linux Red Hat Enterprise | 32 bit x86 All components
Linux 3 AS

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Supported Operating Systems for the OMDB Client
The following table lists the operating systems supported for the OMDB Client.

Table 1-2: OMDB Client Supported Operating Systems

SUPPORTED
OPERATING SYSTEMS VERSIONS ARCHITECTURE
FOR OMDB CLIENT
Windows Windows XP 32 bit x86
Windows 2003 32 bit x86
Windows 2000 32 bit x86

Java J2SE v 1.4.2_13 JRE must be installed on the system that runs on the OMDB Client.
To download this version of Java, go to http://java.sun.com/j2se/1.4.2/download.html

Hardware Requirements for OMDB Core Servers

See the Opsware® SAS Planning and Installation Guide for information on the hardware
requirements.

1 2 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 2: Installing OMDB

This chapter contains the following sections:
« Compatibility
+ Overview
+ Installing OMDB on a Single Server
+ Installing OMDB and SAS on Separate Servers
+ Installing the OMDB Core, the OMDB Database, and SAS on Separate Servers

Compatibility

OMDB 1.0.1 is compatible with the 6.5 version of Opsware SAS. In the SAS Client, check
the version by selecting the Help » About menu item.

Overview

This chapter describes the following install scenarios:

+ Installing SAS, OMDB Core, and the OMDB Database on a single server. SAS and
OMDB share a single Oracle RDBMS. See “Installing OMDB on a Single Server” for
more information.

+ Installing SAS and OMDB on two separate servers. SAS and OMDB have separate
Oracle database instances.

« Installing SAS on one server, the OMDB Core on a second server, and the OMDB
database instance on a third server.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 13
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Installing OMDB on a Single Server

This section describes the concurrent installation of the Opsware OMDB Database and
the Opsware OMDB Core Services on the same server that Opsware SAS is installed on.
The OMDB install process uses the same Opsware Installer application that you used to
install Opsware SAS, and you start it in the same manner. When running the Opsware
Installer, press Ctrl+1 at any time to display online help for the current step.

The OMDB hardware requirements for installation are the same as the Opsware SAS
hardware requirements. For more information, see the Opsware® SAS Planning and
Installation Guide.

Before you begin installing OMDB, you should have the following two pieces of
information:

+ The fully qualified domain name or IP address of the server on which the Opsware
Command Center (OCC) core component is installed.

+ The password for the admin user of the SAS installation (the cast .admin_pwd
parameter value).
Installing SAS
Using the supplied Opsware SAS install DVD, install a SAS 6.5 core.

For more information, see the Opsware® SAS Planning and Installation Guide.

Installing OMDB Using Simple Interview Mode
To install OMDB using the Simple Interview Mode, complete the following steps:
H Log in to the server that you installed SAS on, and then launch a command prompt.

HA Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

EH From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_point>/opsware_installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

14 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 2: Installing OMDB

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 1 5
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To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 9 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:

K Type the password for the admin account on the SAS installation (the

cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

KBl Type the fully qualified domain name or IP address of the server that you are

installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

EH To accept the default value cmdb_admin, press Enter.

The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

1 6 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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As a general rule, consider using a non-default password.

EEl Perform one of the following two actions:
» Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:
All parameters have values. Do you wish to finish the
interview? (y/n):

KK To finish the interview, type vy, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :

EBE To accept the default value /usr/tmp/oiresponse.omdb, press Enter. The
following prompt appears:

Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

K3 To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

To select all, type a, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 17
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EE] To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:
« Typey, then Enter.

» To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

HAEHSHHSHHA SRS HS S H S H S HS AR RS RS RS SHS R R R SRR
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HAEHSHHS A HA SRS H SRS AR RS RS HA R S R R R R H A

Script done on Mon Feb 26 21:39:23 2007

You have completed installing OMDB.

1 8 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Installing OMDB Using Advanced Interview Mode
To install OMDB using the Advanced Interview Mode, complete the following steps:
H Log in to the server that you installed SAS on, and then launch a command prompt.

HA Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

H Fom the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_point>/opsware_installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

Bl To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter
Control-N - go to the next parameter
Return - accept the default (if any) and go to the next

parameter
Control-F - finish parameter entry
Control-I - show this menu, plus information about the

current parameter

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved. 1 9
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Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for
the OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

To accept the default value cmdb_admin for the Oracle system password, press
Enter. The following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user.:

To accept the default value cmdb_admin for the SYS user for the OMDB Oracle
database instance, press Enter. The following prompt appears:

Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KK To accept the default value 80 for the Oracle sizing parameter, press Enter. The

following prompt appears:

Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The

following prompt appears

Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

20 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 2: Installing OMDB

EH Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:

Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:

K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

EI3 To accept the default value 8443, press Enter. The following prompt appears:

Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:

Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:

Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator. [cmdb admin]:

E To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user. [cmdb admin]:
As a general rule, consider using a non-default password.

EXl To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user. [cmdb
admin] :

EH To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EE] Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:

EXA To accept the default value 25, press Enter. The following prompt appears

All parameters have values. Do you wish to finish the
interview? (y/n):

To finish the interview, type vy, then press Enter.

To complete the installation, see step 14 on page 17, and then complete the following
steps.

Enabling the OMDB Client

You must enable OMDB on the SAS server, and you must also create an OMDB group
and add a user to that group before that user can see the Opsware OMDB Client menu
item in the SAS Client.

To enable OMDB in SAS, perform the following steps:
H On the twist server, log in as root.

H Enter the following command:
/opt/opsware/omdb/bin/enable omdb client.sh

H Restart the twist:

22 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.
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/etc/init.d/opsware-sas restart twist

To enable the OMDB Client menu item in the SAS Client, perform the following steps:
H Log in to the SAS Web Client as admin.

A In the Navigation panel, click Administration » Users and Groups. The View Users
pane appears.

HE Click the Groups tab.

Click New Group.

1. Type the Group nhame OMDB.

2. (Optional) Type the Group description.

Click Save. The OMDB group is displayed in the Groups pane.

Click the name (OMDB) of the group you just created.

N B &

In the Edit Group pane, assign the users to the OMDB group.
Click the OMDB Features tab.

In the General Permissions section, select all five of the checkboxes.

KK Click Save.
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Installing OMDB and SAS on Separate Servers

This section describes the installation of the Opsware OMDB Database and the Opsware
OMDB Core Services on a separate server that the SAS server was installed on. The
OMDB install process uses the same Opsware Installer application that you used to install
Opsware SAS, and you start it in the same manner. The OMDB hardware requirements for
installation are the same as the Opsware SAS hardware requirements.

For more information, see the Opsware® SAS Planning and Installation Guide.

Before you begin installing OMDB, you should have the following two pieces of
information:

+ The fully qualified domain name or IP address of the server on which the Opsware
Command Center core component is installed.

+ The password for the admin user of the SAS installation (the cast .admin_pwd
parameter value).
Installing SAS
Using the supplied Opsware SAS install DVD, install a SAS 6.5 core.

For more information, see the Opsware® SAS Planning and Installation Guide.

Installing OMDB Using Simple Interview Mode
To install OMDB using the Simple Interview Mode, complete the following steps:

H Log in to the server you want to install the Opsware OMDB Database and the
Opsware OMDB Core Services on.

H Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

H From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

The following prompt appears:
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Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter
Control-N - go to the next parameter
Return - accept the default (if any) and go to the next

parameter
Control-F - finish parameter entry
Control-I - show this menu, plus information about the

current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:
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Parameter 4 of 9 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:

K Type the password for the admin account on the SAS installation (the

cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

KBl Type the fully qualified domain name or IP address of the server that you are

installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

EH To accept the default value cmdb_admin, press Enter.

The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

As a general rule, consider using a non-default password.

EEl Perform one of the following two actions:
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+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:
All parameters have values. Do you wish to finish the
interview? (y/n):

KK To finish the interview, type vy, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :

EBE To accept the default value /usr/tmp/oiresponse.omdb, press Enter. The
following prompt appears:

Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

E3 To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

To select all, type a, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EE] To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components
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Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:
* Typey, then Enter.

+ To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

FHAHHAHAFHEHH A H A HAH S H SRS R R A R
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HFHAEHHAHAH HEH AR H AR R R R A R R

Script done on Mon Feb 26 21:39:23 2007

You have completed installing OMDB.
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Installing OMDB Using Advanced Interview Mode

To install OMDB using the Advanced Interview Mode, complete the following steps:

Log in to the server you want to install the Opsware OMDB Database and the
Opsware OMDB Core Services on.

Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware

Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry
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Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for
the OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

To accept the default value cmdb_admin for the Oracle system password, press
Enter. The following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user. [cmdb_admin] :

To accept the default value cmdb_admin for the SYS user for the OMDB Oracle
database instance, press Enter. The following prompt appears:

Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KK To accept the default value 80 for the Oracle sizing parameter, press Enter. The

following prompt appears:

Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The

following prompt appears

Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:
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EH Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:

Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:

K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

EI3 To accept the default value 8443, press Enter. The following prompt appears:

Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:

Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:

Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.

31



Opsware® OMDB 1.0.1 Installation Guide

32

Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator. [cmdb admin]:

E To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user. [cmdb admin]:
As a general rule, consider using a non-default password.

EXl To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user. [cmdb
admin] :

EH To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EE] Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:

EXA To accept the default value 25, press Enter. The following prompt appears

All parameters have values. Do you wish to finish the
interview? (y/n):

To finish the interview, type vy, then press Enter.

To complete the installation, see step 14 on page 27, and then complete the following
steps.

Enabling the OMDB Client

You must enable OMDB on the SAS server, and you must also create an OMDB group
and add a user to that group before that user can see the Opsware OMDB Client menu
item in the SAS Client.

To enable OMDB in SAS, perform the following steps:
H On the twist server, log in as root.

A To copy the enable OMDB script from the OMDB server to a temporary directory on
the SAS server, enter the following command:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 2: Installing OMDB

scp omdbserver:/opt/opsware/omdb/bin/enable omdb client.sh /
var/tmp

H Enter the following command:
/opt/opsware/omdb/bin/enable omdb client.sh

B Restart the twist:

/etc/init.d/opsware-sas restart twist

To enable the OMDB Client menu item in the SAS Client, perform the following steps:
E Login to the SAS Web Client as admin.

H n the Navigation Panel, click Administration » Users and Groups. The View Users
pane appears.

Click the Groups tab.

Click New Group.

3. Type the Group name OMDB.

4. (Optional) Type the Group description.

Click Save. The OMDB group is displayed in the Groups pane.

Click the name (OMDB) of the group you just created.

(< o o

In the Edit Group pane, assign the users to the OMDB group.

Click the OMDB Features tab.

In the General Permissions section, select all five of the checkboxes.

KK Click Save.
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Installing the OMDB Core, the OMDB Database, and SAS
on Separate Servers

This section describes the installation of SAS on one server, the OMDB Core on a second
server, and the OMDB database instance on a third server. The OMDB install process
uses the same Opsware Installer application that you used to install Opsware SAS, and
you start it in the same manner. The OMDB hardware requirements for installation are the
same as the Opsware SAS hardware requirements.

For more information, see the Opsware® SAS Planning and Installation Guide.

Before you begin installing OMDB, you should have the following two pieces of
information:

+ The fully qualified domain name or IP address of the server on which the Opsware
Command Center core component is installed.

* The password for the admin user of the SAS installation (the cast.admin_ pwd
parameter value).
Installing SAS

Using the supplied Opsware SAS install DVD, install a SAS 6.5 core on one of the three
servers. This server will be referred to as the SAS server in this section.

For more information, see the Opsware® SAS Planning and Installation Guide.

Installing OMDB Using Simple Interview Mode
To install OMDB using the Simple Interview Mode, complete the following steps:

H Log in to the server you want to install the Opsware OMDB Database Services on.
This server will be referred to as the OMDB Database server.

H Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

H From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.
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The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:
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To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 9 (omcs.occHost)Please enter the hostname or

IP of the server where the SAS OCC service is running.:

B Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed on, then press Enter. The
following prompt appears:

Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

El To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:

KK Type the password for the admin account on the SAS server (the cast .admin
passwd parameter value), then press Enter. The following prompt appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost) .:

EEl Type the fully qualified domain name or IP address of the server that you will install
OMDB Core Services on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

EH To accept the default value cmdb_admin, press Enter.

The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

As a general rule, consider using a non-default password.
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EEl Perform one of the following two actions:

» Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

All parameters have values. Do you wish to finish the
interview? (y/n):

K To finish the interview, type y, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :

EE To accept the default value /usr/tmp/oiresponse . omdb, press Enter. The

following prompt appears:

Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

K To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 ( ) Oracle RDBMS for OMDB
2 () Opsware OMDB Database Instance
3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

To select Opsware Oracle RDBMS for OMDB and Opsware OMDB Database

Instance, type 1, then press Enter, and then type 2, then press Enter. The following
prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 () Opsware OMDB Core Services
Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:
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EE] To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:
« Typey, then Enter.

» To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

HAEHSHHSH SRS RS H S H SRS H SRS RS RS S R R R R H R
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HAEHSHHSH SRS SRS H S HS SRS H AR HAH S HH  H HA S R

Script done on Mon Feb 26 21:39:23 2007

EX On the server that you intend to install OMDB Core Services on, open a command
prompt.
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EXl To copy the oiresponse . omdb file from the OMDB Database server to the OMDB
Core server, enter the following command:

scp omdbdatabaseserver:/usr/tmp/oiresponse.omdb

EH Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

EEl From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:
/<mnt_points>/opsware installer/install opsware.sh -r /usr/
tmp/oiresponse.omdb

EXA To continue, type vy, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EH To select Opsware OMDB Core Services, type 3, then press Enter. The following
prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EX3 To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

Perform one of the following two actions:

* Typey, then Enter.
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+ To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Opsware OMDB Core Services

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.22:30:54 verbose.log

HEHSHHSHHEHHE S HS S HS S H S H SSRGS RS RS S HS R R  S R  H R
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.

FHEFH R R

Script done on Mon Feb 26 22:39:23 2007

You have completed installing OMDB.

Installing OMDB Using Advanced Interview Mode

To install OMDB using the Advanced Interview Mode, complete the following steps:

Log in to the server you want to install the Opsware OMDB Database Services on.

Mount the Opsware OMDB install DVD labeled “Disc Two” using a command similar
to mount /dev/cdrom as appropriate.

From the Opsware OMDB install “Disc Two” DVD, start the Opsware Installer using
the following command:

/<mnt_points>/opsware installer/install opsware.sh
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Start the Opsware Installer using the fully qualified path name. Do not start the Opsware

AN
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

B To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter
Control-N - go to the next parameter
Return - accept the default (if any) and go to the next

parameter
Control-F - finish parameter entry
Control-I - show this menu, plus information about the

current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:

H Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :
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To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for
the OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

To accept the default value cmdb_admin for the Oracle system password, press
Enter. The following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user.:

To accept the default value cmdb_admin for the SYS user for the OMDB Oracle
database instance, press Enter. The following prompt appears:

Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KK To accept the default value 80 for the Oracle sizing parameter, press Enter. The

following prompt appears:

Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The

following prompt appears

Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

EH Type the fully qualified domain name or IP address of the server that the Opsware

Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:

Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:
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K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

E3 To accept the default value 8443, press Enter. The following prompt appears:

Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:
Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:
Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:
Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator. [cmdb admin]:

H To accept the default value cmdb_admin, press Enter. The following prompt appears:
Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user. [cmdb_admin]:
As a general rule, consider using a non-default password.

EXl To accept the default value cmdb_admin, press Enter. The following prompt appears:

Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user. [cmdb_
admin] :

ER To accept the default value cmdb_admin, press Enter. The following prompt appears:
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Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EEl Perform one of the following two actions:
» Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:

EXA To accept the default value 25, press Enter. The following prompt appears

All parameters have values. Do you wish to finish the
interview? (y/n):

To finish the interview, type v, then press Enter.
To complete the installation, see step 14 on page 37, and then complete the following
steps.
Enabling the OMDB Client

You must enable OMDB on the SAS server, and you must also create an OMDB group
and add a user to that group before that user can see the Opsware OMDB Client menu
item in the SAS Client.

To enable OMDB in SAS, perform the following steps:
H On the twist server, log in as root.

H To copy the enable OMDB script from the OMDB server to a temporary directory on
the SAS server, enter the following command:

scp omdbserver:/opt/opsware/omdb/bin/enable omdb client.sh /
var/tmp

E Enter the following command:
/opt/opsware/omdb/bin/enable omdb client.sh

B Restart the twist:

/etc/init.d/opsware-sas restart twist

To enable the OMDB Client menu item in the SAS Client, perform the following steps:
H Log in to the SAS Web Client as admin.

H n the Navigation Panel, click Administration » Users and Groups. The View Users
pane appears.

E Click the Groups tab.
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B Click New Group.

5. Type the Group name OMDB.

6. (Optional) Type the Group description.

Click Save. The OMDB group is displayed in the Groups pane.

Click the name (OMDB) of the group you just created.

[~ o |

In the Edit Group pane, assign the users to the OMDB group.
Click the OMDB Features tab.

In the General Permissions section, select all five of the checkboxes.

KK Click Save.
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This chapter contains the following sections:
« Supported Data Sources
* Pre-registering the Data Miner on OMDB
+ Installing a Data Miner on a SAS or NAS Server
« Installing a Data Miner on a NAS Windows Server

+ Installing Transaction Mining Triggers for NAS

Supported Data Sources

The following list of data sources are supported for OMDB Data Miners:

* Oracle 9i (9.2.0.7)

Oracle 10g (10.2.0.2)

SAS 6.5

NAS 6.0.2, 6.1, 6.2.1

Pre-registering the Data Miner on OMDB

You will need to pre-register your Data Miner(s) on the OMDB server. This will set up all of
the information needed by a Data Miner to connect to its data source. As part of the
process, you will create a registration token that you will use when configuring the Data
Miner on the SAS and NAS servers.
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Pre-registering the Data Miner on OMDB at the Command Line

You can use the command line option to preregister the Data Miner. All values can be
entered on a single command line, and you can skip the entire interactive configuration
that is shown in “Pre-registering the Data Miner on OMDB Interactively Using
dmconfig.sh”. The database and user/password information on this example command
line are for the SAS or NAS database, not OMDB.

When prompted for a user name and password, use cmdb_admin / crndb_admin.

Use the local portion of the fully-qualified domain name of the SAS server in place of
SASserver in the example. If the fully-qualified name of the SAS server is
developmentl.example.com, uUse developmentl following the --name option.

For details on the parameters, see “Pre-registering the Data Miner on OMDB Interactively
Using dmconfig.sh”.
cd /opt/opsware/omdb/bin
./dmconfig.sh --add --name SASserver --desc SAS on SASserver
--type SAS --driver Oracle Driver --properties

database=SASserver.example.com:1521:truth,user=opsware__
admin, password=opsware_admin

Write down the registration token that appears after you run this command. You will need
to enter it later when configuring the Data Miner on the SAS or NAS server. Registration
tokens are upper-case text.

Pre-registering the Data Miner on OMDB Interactively Using dmconfig.sh

H Run the Data Miner configuration tool dmconfig. sh with the following two
commands:

cd /opt/opsware/omdb/bin
./dmconfig.sh

The following prompt should now be displayed:
[ DMConfigure <]

H At the [ DMConfigure <] prompt, the following commands are supported:
« ADD: Displays the prompts that enable you to generate a registration token.

+ UPDATE: Displays a list of properties, noting the required properties. Enter
keyvalue pairs until done, and then press Enter to end.
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« LIST: Displays current Data Miner configurations.
* QUIT: Exits the prompt.

(Optional) You may be prompted for the database information for the OMDB server.
Unless you made changes during the installation, use the following values. (If not
prompted for some or all of these, it's because the values were found in
dmconfig.properties.)

« Database [host:port:sid]: localhost:1521:cmdb

» Userid : cmdb_admin

+ Password : cmdb_admin

Type add, then press Enter.

Follow the prompts to generate a new registration token.

* Name: Enter a short name for the data source you are planning to mine.

Example: SASserver

+ Description: Enter a meaningful name.

Example: SAS on SASserver

« Connection Template ID: Enter the number listed for Oracle Driver (probably 1).

Pick source ID: Enter 1 for NAS or 2 for SAS.

The following example shows how this step should display:

[ DMConfigure <] add
Name : m500
Description : SAS on SASserver

ID NAME

1 Oracle Driver
Connection template ID : 1

ID NAME

1 SAS

2 NAS

Source type id : 1
REG TOKEN is WD2K5R
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Write down the registration token (in the example, registration token is the string
AN
WD2K5R). You will need to enter it later when configuring the Data Miner on the SAS or
NAS box.

Now that the initial add is complete, you need to update the specific database
configuration for the Data Miner source.

[l Atthe [ DMConfigure # <] prompt type update, then press Enter.

Select the configuration you want to update. Because there is only a single
configuration at this point, select 1. The following prompt appears:

[ DMConfigure # <] update
ID NAME DESCRIPTION TOKEN

1 SASserver SAS on SASserver EM1U6O
ID to update : 1

B Set the connection information that the Data Miner (to be installed shortly on the SAS
or NAS server) will use to connect to its local source database (use lowercase). Each
time you enter a value, the current values for the Data Miner source will display.

These values are for the SAS or NAS database, not the OMDB database. Your values
will look similar to the following example:

database=10.124.6.02:1521:truth (Note that database is of
the format host:port:sid)

user=opsware_admin

password=opsware_admin

(Optional) If NAS is not installed with a user name of system, set the value
EtlTableOwnerOverride=user = log

For Oracle, set the user to the name of the database user who owns the table. For
SQL Server, set the user to the name of the SQL Schema that contains the table.

El When you are finished, press Enter to exit edit mode and return to the prompt.

KB Type quit, and then press Enter. The OMDB server-side configuration for the Data
Miner is now complete.
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Installing a Data Miner on a SAS or NAS Server

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine - the actual SAS or NAS server.

Log in to the SAS or NAS server.

Do a remote copy of dataminer.tar from /opt/opsware/omdb/dist on the OMDB server
to a local directory such as /opt/opsware/dataminer. The commands used for this
step are shown in the following example:

mkdir -p /opt/opsware/dataminer

cd /opt/opsware/dataminer

scp youromdbserver:/opt/opsware/omdb/dist/dataminer.tar /
opt/opsware/dataminer

Untar the file:

cd /opt/opsware/dataminer

tar -xvf dataminer.tar

Run the dataminer setup using the following command:
./dmsetup.sh

The following prompt appears:

Please enter the registration token provided after this
dataminer was configured on the OMDB server: []

Enter the token that was generated by registration on the OMDB server. (You were
told to write it down earlier in these instructions. It will be a secure one-use mixture of
about 6 upper-case letters and digits.) The following prompt appears:

Updating token in dataminer.conf

Would you like to have dataminer automatically start up when
the system reboots? [y/nl]

Type vy, then press Enter. The following prompt appears:

Dataminer is now configured for startup:

opsware-dataminer 0:0ff 1l:0ff 2:on 3:on 4:on 5:on 6:0ff

To exit dmsetup. sh, type vy, then press Enter.

(SAS only) To enable mesh vault mining, add the following lines to vault.conf:

# Data Miner configuration
cmdbshareddirectory=/var/opt/opsware/vault/spool
cmdbbufferflushsize=15360
cmdbbufferflushtimeout=2000

cmdbmaxfileage=3
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Start the Data Miner dataminer.sh:

cd /opt/opsware/dataminer
./dataminer.sh start

KK Tail the dataminer.log to observe progress.

tail -f dataminer.log

You should see the tail of the Data Miner log display content similar to the following
example:

INFO - - - - - "Configuration Path = /opt/opsware/dataminer"
INFO - - - - - "Using configuration file /opt/opsware/
dataminer/dataminer.conf"

INFO - - - - - "Initializing..."

INFO - - - - - "Running on Linux"

INFO - - - - - "Cached Configuration file has been updated,
reloading"

INFO - - - - - "Boot certificate not found Attempt to import"
INFO - - - - - "Boot certificate successfully imported"

INFO - - - - - "DataMiner successfully registered"

EEl When you are satisfied that the Data Miner is correctly configured and collecting

data, you can stop the tail command.

Installing a Data Miner on a NAS Windows Server

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine - the actual NAS server.

On the Windows NAS server, create a directory such as C:\dataminer.

Copy the dataminer. zip and dmboot .pem file from /opt/opsware/omdb/
dist on the OMDB server to a local directory such as C:\dataminer.

Unzip the dataminer. zip file. Keep the directory structure intact.

Edit the file jvm.properties. Update the JVM-Path value to the correct location of
JVM.DLL for the Java Runtime Environment 1.4.2.

Edit the dataminer.conf file using the following example:

#OpswareGateway=host:port
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CMDBLocation=10.10.10.10:8443
RestartableCopyLocation=10.10.10.10:8873
RegistrationToken=ToKeN
LogLevel=INFO

* Leave OpswareGateway as a comment (preceded by #)

* Set CMDBLocation to the OMDB Server <host>:8443

* SetRegistrationToken tothe token generated at registration on the OMDB
Server

* RestartableCopyLocation should be set to the same IP address as CMD-
BLocation:8873

Open a Windows command prompt.

=

Change directory to C:\dataminer.

To install the service, run the following command:

DataMinerService -install

El To start the service, run the following command:
DataMinerService -start

Installing Transaction Mining Triggers for NAS

This section describes how to install transaction mining triggers for a NAS installation on a
Linux or Solaris server using Oracle, or for a NAS installation on a Windows server using
Oracle.

Installing Transaction Mining Triggers for NAS with Oracle on Linux or
Solaris

This section describes how to install transaction mining triggers for a NAS installation on a
Linux or Solaris server using Oracle.

You will need the following information before you begin:
+ the Oracle SID of the NAS database instance
« the Oracle database user owning the NAS table

+ an existing tablespace with 100MB available for OMDB transaction data
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To install transaction mining triggers on a NAS Linux or Solaris server, perform the
following steps:

H Stop the OMDB Data Miner if it is running.
A Log in to the NAS database server as user oracle.

E Confirm the files in the /opt/opsware/dataminer/triggers/oracle on the
OMDB server are accessible by the oracle user on the NAS database server. If the
Data Miner installation is on another server, copy the /opt/opsware/
dataminer/triggers/oracle directory to the NAS database server.

Bl Open a comand prompt, and then run the following command:

/opt/opsware/dataminer/triggers/oracle/deploy nas_
triggers.sh

H Respond to all prompts.

@ (Optional) If you stopped the Data Miner in the first step, restart it.

Installing Transaction Mining Triggers for NAS with Oracle on Windows

This section describes how to install transaction mining triggers for a NAS installation on a
Windows server using Oracle.

You will need the following information before you begin:

+ the Oracle SID of the NAS database instance

+ the Oracle database user owning the NAS table

+ an existing tablespace with 100MB available for OMDB transaction data

To install transaction mining triggers on a NAS and Oracle Windows server, perform the
following steps:

E Stop the OMDB Data Miner if it is running.

B Log in to the NAS database server as a user that is a member of the ORA_DBA
group.

E Confirm the files in the /opt/opsware/dataminer/triggers/oracle on the
OMDB server are accessible by the the ORA_DBA group member user on the NAS
database server. If the Data Miner installation is on another server, copy the /opt/
opsware/dataminer/triggers/oracle directory to the NAS database server.
A suggested location is C: \opsware\dataminer\triggers\oracle
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Confirm the sglplus.exe application is in the user’s path.

In the C:\opsware\dataminer\triggers\oracle directory, run the following
command:

deploy nas_triggers.cmd

Respond to all prompts.

(Optional) If you stopped the Data Miner in the first step, restart it.
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This chapter contains the following sections:
« Start Script
* Viewing OMDB Permissions
+ Creating and Assigning Security Boundaries

+ OMDB Filesystem Layout

Start Script

This section describes the opsware-omdb script used to start OMDB. After installation,
the script is located in the /etc/init.d/ directory:

/etc/init.d/opsware-omdb

The opsware-omdb script has the following options:
® start
e stop
® startsync
e restart
e list
e status

For more information on these options, see the Opsware® SAS Administration Guide.
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Viewing OMDB Permissions

This section describes how to view OMDB permissions for an existing group, and the
definitions of the permission settings.

Viewing the OMDB Permissions
To view the OMDB permissions, perform the following steps:
E Login to the SAS Web Client as admin.

H n the Navigation Panel, click Administration » Users and Groups. The View Users
pane appears.

E Click the Groups tab.
Bl Select a group. The group is displayed in the View Groups pane.
H Click the OMDB Features tab.

If a user has no OMDB permissions, the SAS Client will not display the Opsware OMDB
Client item on the Tools menu.

OMDB Permissions
The General Permissions section has the following five checkboxes

+ Schedule Reports - This permission causes the OMDB Client to display the Schedule
Reports item in the View » Reports menu. It also enables the Schedule button when
the user views a specific report.

+ Manage Scheduled Reports - This permission causes the OMDB Client to display the
Manage Scheduled Reports item in the View » Opsware Administration menu. The
user can see scheduled reports of other users, set the maximum number of scheduled
reports per user, and set the maximum number of reports to be concurrently processed
by a server. This permission grants access to only the report definitions of scheduled
reports. If the user runs a report created by another user, the data displayed depends
on the Data Access permissions. If the user runs a report that attempts to display data
the user does not have access to, the report displays the following message: “There is
no data that matches your criteria”.

+ Manage Security Boundaries -Selecting Manage Security Boundaries adds the Security
Boundaries command on the menu View » Opsware Administration command of the
OMDB Client to members of the group. The user can create security boundaries.
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+ Administer OMDB System - Selecting Administer OMDB System permits the user
access to CDK-related APIs.

« All Data Access Permissions - Selecting the All Data Access Permissions check box
grants members of the group access to all data in OMDB. Clear the check box, then
use the Data Access section to grant data access to only selected categories.

Data Access
The Data Access section of the OMDB Features tab has two sections:
* NAS Category and Permission

+ SAS Category and Permission

Each section describes one row for each Configuration Item (Cl) Type in that section. If
custom CI Types are defined in the SAS installation, those data types are displayed in a
third section labeled Other.

For each Cl Type, set the permission for the group by selecting either None, All, or
Security Boundary. If you select Security Boundary, click Select to display the Select
Security Boundaries window.

Creating and Assigning Security Boundaries

The Security Boundaries feature allows you to choose custom search parameters that you
can then save and assign to a user or a group of users in OMDB. You can define a
Security Boundary as one or more attributes of one or more configuration items. You
create a security boundary in the OMDB Client. You assign security boundaries in the SAS
Web Client.

If you select Security Boundary, click Select to display the Select Security Boundaries
window.

Creating Security Boundaries

To create a security boundary, perform the following steps:

HF Launch the SAS Client. The SAS Client appears.

H From the Tools menu, select Opsware OMDB Client. The Opsware OMDB Client
window appears.

E From the View menu, select Opsware Administration » Security Boundaries.
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Select a Configuration Iltem from the drop-down list.

In the drop-down list for (the Asset Tag, Hostname, and so on), select Contains,
Equals, or the appropriate association.

In the text field, type the appropriate value.

(Optional) Click + and then repeat the preceding three steps to define a second
criteria.

Click Preview Security Boundary to view the current items defined within the
security boundary.

Click Save to save the security boundary.

Assigning Security Boundaries

To assign a security boundary to a group, perform the following steps:

Log in to the SAS Web Client as an administrator. The SAS Web Client Home Page
appears.

In the Navigation Panel, click Administration » Users & Groups. The View Users
pane is displayed.

Click the Groups tab. The Groups tab is displayed.

Select the group you want to set a security boundary for. The group is displayed in
the View Groups pane.

Click the OMDB Features tab. The OMDB Features tab is displayed.
Clear All Data Access Permissions.

For the CI Type you want the group to use a security boundary for access to that
data, select the Security Boundary option.

Click Select. The Select Security Boundaries window is displayed.

Click a security boundary in the Unassigned Boundaries list, and then click -> to
move the selected security boundary to the Assigned Boundaries list.

Kl Click Save. The Select Security Boundaries window closes.

EEl In the OMDB Features of the View Groups pane, click Save.

60 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2007 Opsware Inc. All Rights Reserved.



Chapter 4: Administration

You can select multiple security boundaries in the Select Security Boundaries window to
control data access for a single CI Type. Users that are members of groups with different
security boundaries for data access have access to all the data viewable by the individual
groups. For example, suppose a user is a member of two groups:

« SAS Users - Security boundary defined for all SAS data
» NAS Users - Security boundary defined for all NAS data

The user can see all the Cl Types for both SAS data and NAS data.

OMDB Filesystem Layout

This section describes the filesystem layout of the Opsware OMDB Database and the
Opsware OMDB Core Services. The default OMDB database filesystem layout is
presented in Table 4-1.

Table 4-1: OMDB Database Filesystem Layout

/uol/ Location of Oracle application, instance
admin files, and a control file

/u0l/app/oracle/product/ config for OMDB instance
10.2.0/db_1/network/admin/

tnsnames.ora

/u0l/app/oracle/product/ config for OMDB instance
10.2.0/db_1/network/admin/

tnslistener.ora

/u0l/app/oracle/product/ OMDB password file
10.2.0/db_1/dbs/orapwomdb

/u0l/app/oracle/product/ OMDB config file
10.2.0/db_1/dbs/spfileomdb.ora

/u0l/opp/oracle/admin/cmdb/
bdump, cdump, pfile, udump

/u01l/opp/oracle/admin/cmdb/ Scripts to create database
create
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Table 4-1: OMDB Database Filesystem Layout

/u0l/opp/oracle/admin/cmdb/
create/metaschema

/u0l/opp/oracle/admin/cmdb/

dataschema
/u0l/oradata/cmdb
/u02/
/u02/oradata/cmdb

/u03/oradata/cmdb

/u04

/u04/oradata/cmdb

/etc/oratab

Schema creation scripts

Data creation scripts

OMDB control file #1
Location of data files
OMDB data files

CMDB control file #2, and redo logs group
#1

Location of second member of redo log
groups, and a control file

CMDB control file #1, and redo logs group
#2

Entry for OMDB instance
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The default OMDB Core Services filesystem layout is presented in Table 4-2.

Table 4-2: OMDB Core Services Filesystem Layout

/opt/opsware/omdb

/opt/opsware/omdb/bin
/opt/opsware/omdb/cert

/opt/opsware/omdb/dist

/opt/opsware/omdb/conf

/opt/opsware/omdb/deploy

/opt/opsware/omdb/deploy/

birt.war
/opt/opsware/omdb/omdb

/opt/opsware/omdb/omdb/deploy/

/opt/opsware/omdb/omdb/deploy/

jbossweb-tomcat55.sar
/opt/opsware/omdb/reports
/var/opt/opsware/omdb/collect
/etc/opt/opsware/omdb
/etc/inet.d/opsware-omdb

/var/log/opsware/omdb/
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Root of the primary install location (OMCS_
ROOQOT DIR)

Location of OMCS binary executable
JBoss cert file directory

Location where the Dataminer installer and
cert are deployed

JBoss configuration dir (OMCS_JBOSS _
CONFIG_DIR)

OMDB JBoss deploy files that are not in
OCC, such as loadersar, cooper.jar, and so
on

BIRT Engine

Hierarchy the same as SAS OCC

JBoss deployment, hierarchy the same as
SAS OCC

Apache webserver deployment directory

OMDB report definitions

Location of OMCS Loader Collect directory
Location of OMCS configuration files
Location of OMCS daemon launch script

Log files for OMDB
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